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П
ри отказе от использования P�CAD и переходе к про�

ектированию в среде Altium Designer необходимо

обеспечить по возможности безболезненный переход

от одного формата данных к другому, чтобы можно

было поддерживать и разви�

вать ранее выполненные

проекты. Altium Designer

предоставляет средства такой

конверсии – Import Wizard

(мастер, или дословно – вол�

шебник импорта).

Конвертироваться могут до�

кументы проектов P�CAD

(листы электрических схем

и документы печатной пла�

ты) и библиотеки компо�

нентов. Документы проек�

тов конвертируются из ис�

ходного двоичного формата

P�CAD Binary. Библиотеки,

подлежащие конверсии, должны быть предварительно преоб�

разованы в среде Менеджера библиотек P�CAD 200x Library

Executive в текстовый формат P�CAD ASCII.

Конверсия структуры данных P�CAD 200x в формат Altium

Designer запускается командой File → Import Wizard. Открыва�

ется первая страница Мастера импорта. Переход со страницы

на страницу Мастера управляется кнопками Next/Back. На вто�

рой странице Мастера (рис. 1, на переднем плане) следует вы�

брать исходный формат данных.

Применительно к нашему случаю выбираем формат исходных

данных P�CAD Design and Libraries Files и щелчком по кнопке

Next переходим к следующим шагам, на которых пользователю

предоставляется возможность выбора файлов проекта и/или

библиотек для импорта.

Список проектных документов и библиотечных файлов со�

ставляется по щелчкам на кнопке Add, открывающей стандарт�

ную процедуру поиска файлов. Пути к каждому найденному

файлу помещаются в поле P�CAD Design Files или P�CAD Library

Files в главном поле окна (рис. 2).

На следующем, промежуточном шаге в окне Ма�

стера отображается процесс анализа исходной ин�

формации, подлежащей конверсии.

На пятой странице Мастера Import Wizard определяется

формат имени топологического посадочного места (ТПМ)

библиотечных компонентов (Footprint) при конверсии

(рис. 3).

В отличие от P�CAD, в котором описания контактов компо�

нента и связи электрических контактов с контактными пло�

щадками посадочного места, а также признаки эквивалентно�

сти контактов и логических секций сосредоточены в структуре,

объединяющей схемный символ (Symbol) с посадочным мес�

том (Pattern) в интегрированный библиотечный компонент,

при конверсии в формат Altium Designer все эти данные разво�

дятся в двух направлениях:

� данные, относящиеся к схемному символу, передаются в

структуру элемента библиотеки схемного редактора

AdvSCH;

� графика посадочного места и описания контактных площа�

док передаются в структуру элемента библиотеки графиче�

ского редактора печатной платы AdvPCB.

Компания Altium (Австралия) – ведущий мировой
производитель программного обеспечения для
проектирования электронных устройств на базе
печатных плат (Altium Designer, P�CAD,
NanoBoard). Altium Designer – программа, которая
является продолжением и развитием широко
распространенных в России систем P�CAD и
Protel. Статья посвящена техническим аспектам
перехода с P�CAD на Altium Designer.
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Конверсия данных
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Чтобы исполнитель отчетливо представлял себе особенности

конверсии, в верхнем поле диалогового окна выводится об�

ширное информационное сообщение, разъясняющее особен�

ности образования имен посадочных мест. Структура данных

P�CAD отличается от структуры данных Altium Designer. В

Altium Designer ТПМ компонента (Footprint) не может иметь

несколько альтернативных графических изображений. Кон�

тактная площадка (КП) в Altium Designer должна иметь един�

ственное обозначение, в отличие от P�CAD, где обозначения

контактов Pin Designator могут отличаться от обозначений КП

Pad Number в посадочном месте.

Вследствие этих разли�

чий имена контактных

площадок PCB�компо�

нентов могут приобре�

тать различные формы,

вид которых определяет�

ся в диалоге. По умолча�

нию имя ТПМ состоит из

трех полей, в которых

отображается имя ТПМ,

назначенное в P�CAD

(Pattern Name), имя биб�

лиотечного компонента

(Component Name) и имя

(Pattern Graphics) основ�

ной (Primary) или альтер�

нативной графики ТПМ. В каждом из полей эти имена могут

быть изменены выбором из раскрывающегося списка или по�

ле может быть оставлено пустым при указании варианта None.

Может также быть выбран разделитель полей в имени поса�

дочного места в Altium Designer – точка, дефис или скобки.

Эта форма может также быть оптимизирована. Формат имени

ТПМ оптимизируется к виду <pattern name>_<pattern graphics

name> (<имя ТПМ>_<имя графики ТПМ>   прим. авт.), если

обозначение выводов компонента Pin Designator в библиотеке

P�CAD то же, что и обозначение контактных площадок Pad

Number. Далее этот формат оптимизируется к виду <pattern

name>, если ТПМ имеет единственную графику. Для лучшей

совместимости следует конвертировать проекты и библиотеки

P�CAD, используя единую настройку формата имен.

Ниже этого сообщения располагается строка с полями наст�

ройки формата имени ТПМ и примеры оптимизированного

и, если таковое окажется в проекте, неоптимизированного

имени ТПМ.

Если имена контактов компонента Pin Designator и контактов

на посадочном месте (Pattern) Pad Number не совпадают, опти�

мизация имени посадочного места при конверсии библиотеч�

ных компонентов из P�CAD в Altium Designer не выполняется,

как это показано на рис. 3 для электрического соединителя

СНП34�69, у которого обозначения контактов Pin Des в табли�

це Pins View библиотеки P�CAD выполнены как в цоколевке

соединителя – А1…A23, B1…B23, C1…С23, а контактные пло�

щадки ТПМ (Pad #) пронумерованы подряд – 1…69.

На следующем шаге программа предлагает ознакомиться с

форматом имени компонента схемной библиотеки Altium

Designer (рис. 4).

В верхнем поле окна выводится информационное сообщение

о различиях концепции схемного символа P�CAD и компо�

нента схемной библиотеки Altium Designer. Такие данные, как

графика схемного символа, атрибуты, логические секции,

имена и типы контактов, связь контактов символа и контакт�

ных площадок ТПМ библиотечных компонентов P�CAD, ста�

новятся принадлежностью компонента схемной библиотеки

Altium Designer. Каждый компонент P�CAD импортируется

как компонент схемной библиотеки Altium Designer под име�

нем, совпадающим с именем компонента библиоте�

ки P�CAD. Что касается кодов эквивалентности вы�

водов и секций, то они назначаются компонентам

непосредственно в схемном документе проекта

Altium Designer.

В расположенном ниже поле приводятся примеры

оптимизированного и неоптимизированного имени

схемного компонента. Не оптимизируются имена

многосекционных компонентов.

На следующем шаге (рис. 5) следует установить со�

ответствие слоев графического редактора печатной

платы P�CAD PCB и слоев редактора печатной пла�

ты AdvPCB Altium Designer. Настройка выполняется

как для документов печатной платы, так и для биб�

лиотек посадочных мест Altium Designer.

На следующих двух шагах в окне Мастера (рис. 6) отображает�

ся структура конвертированных данных. Для каждого из про�

ектных документов P�CAD   листа электрической схемы и до�

кумента печатной платы – Altium Designer образует отдельный

PCB�проект. В дереве структуры каждого из проектов отобра�

жается имя исходного документа и имена конвертированных

документов.

Библиотека P�CAD конвертируется в структуру библиотечного

пакета Altium Designer (в нашем примере   S_K1533.LIBPKG):

исходный документ делится на два библиотечных файла –

файл схемной библиотеки S_K1533.SCHLIB и файл библиоте�

ки ТПМ S_K1533.PCBLIB. Одновременно с этим файлы кон�

вертированного библиотечного пакета компилируются в ин�

тегрированную библиотеку S_K1533.INTLIB. Все эти файлы

сохраняются в подкаталоге . .\ Imported S_K1533.LIA\ исход�

ного библиотечного каталога.

На заключительном шаге в окне Мастера отображается ход

конверсии (рис. 7). Вмешательство оператора в ход конверсии

невозможно: все кнопки управления заблокированы. Кноп�

кой Finish завершаем преобразование.

Импортированные документы отображаются в виде структу�

ры проектов в панели Projects и по обычным правилам вызы�

ваются для редактирования в главное графическое окно про�

граммы.

Проекты P�CAD, выполненные в метрической системе еди�

ниц измерения, передаются в Altium Designer в "имперской"

(дюймовой) системе, хотя реальные миллиметровые размеры

элементов проекта сохраняются и могут быть восстановлены

при активизации функции настройки Document Options в схем�

ном редакторе и Board Options в редакторе печатной платы.

Конвертированный схемный документ сохраняет графическое

изображение, сформированное в P�CAD, включая бланк�фор�

матку со всеми записями в основную надпись. При этом пара�

метрами нового схемного документа становятся только те рек�

визиты исходного документа, имена которых совпадают с

именами параметров документа Altium Designer.

В конвертированном схемном документе (рис. 8) имена всех

цепей показываются явно. При этом к цепям, не обозначен�

программное обеспечение

67CADmaster | 2011 | №1

Рис. 4

Рис. 5



ным в исходном документе P�CAD пользова�

тельскими именами, присоединяются метки

Net Label с именами вида NET000nn, совпада�

ющими с именами в исходном документе.

Линии групповой связи схемного документа P�CAD конверти�

руются в Altium Designer как графические. Это неудивительно:

в P�CAD не существует такого объекта, как логическая линия

групповой связи. При этом относительно самой линии, объе�

диняющей индивидуальные линии в групповую, выводится

предупреждение Unconnected Line – несоединенная линия.

Остановимся на особенностях конверсии многолистовых схем.

Концепции многолистового схемного документа P�CAD и

Altium Designer существенно различаются.

Многолистовой схемный документ P�CAD представляет собой

единый файл, содержащий несколько фрагментов большой

схемы, электрическая связность которых определяется нали�

чием глобальных цепей, помеченных метками Port. Такой до�

кумент легко приводится в соответствие требованиям стандар�

тов ЕСКД, размещается на листах стандартного формата с ос�

новной надписью по ГОСТ 2.104�2006 и при его нормоконтро�

ле не возникает осложнений.

При конверсии многолистового схемного документа P�CAD в

Altium Designer формируется PCB�проект, в структуре которого

каждый лист исходного документа представляется как отдель�

ный схемный документ. При этом имя исходного схемного

файла P�CAD теряется, а новым схемным документам (рис. 9)

присваиваются имена Sheet1.SCHDOC Sheet2.SCHDOC и т.д.

Кроме того, для каждого из этих листов генерируются иерархи�

ческие схемные символы, и из них автоматически составляет�

ся схемный документ верхнего уровня, называемый верхним

листом проекта (Project Top Sheet) с именем

First_Sheet.SCHDOC. 

При этом линии связи исходного

документа, переходящие с листа на

лист и обозначенные в P�CAD мет�

ками Port, в конвертированных до�

кументах Altium Designer обозна�

чаются метками Net Label. В верх�

нем листе проекта метки цепей не

конвертируются в соединители ли�

стов Sheet Entry, то есть образуется

один из вариантов иерархии, в ко�

торой метки цепей образуют гло�

бальные связи1. После компиля�

ции проекта эта многолистовая

схема может быть реализована на

печатной плате.

Результаты преобразования схем�

ного документа неоднозначны.

Конвертированная схема визуально воспринимается нормаль�

но: все компоненты на своих местах, все электрические соеди�

нения как�будто бы выполнены. Однако, при ее компиляции в

панель Messages выводятся сообщения о таких ошибках, как раз�

рывы цепей, "плавающие" (оторванные от цепи) метки цепей,

"плавающие" контакты компонентов, к которым, казалось бы,

нормаль но подходят линии электрической связи. При попытке

построить по такой схеме печатную плату эти связи теряются.

Индивидуальные линии электрических связей, включенные в

линию групповой связи и обозначенные в исходном докумен�

те P�CAD метками Port, в конвертированном схемном доку�

менте обозначаются, как правило, метками Net Label, а также,

частично,   метками Port. Эти разнородные метки могут ока�

заться подключенными к сегментам одной и той же линии свя�

зи, имеющей в исходном документе единую метку Port. В таких

случаях в панель Messages выводится сообщение об ошибке ви�

да Duplicate Net Names Wire nn (дублирование имен цепей у

проводника nn).

Речь здесь не может идти об ошибках в исходной схеме. Все эти

несообразности выявились в конвертированных схемах, по ко�

торым в свое время в среде P�CAD 2002�2006 были успешно

спроектированы печатные платы. 

Конвертированный документ печатной платы (рис. 10) сохра�

няет геометрическую форму и размеры платы только в том слу�

чае, если в исходном документе контур платы был выполнен в

отдельном несигнальном слое и передан при конверсии в один

из механических слоев Altium Designer. В противном случае

контуром платы (Board Shape) оказывается область, очерчен�

ная в документе P�CAD в слое Board.
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Рис. 6

Рис. 7

Рис. 8

Рис. 9

Документ HELP�системы AR0123 Connectivity and Multi�Sheet Design.pdf.



Геометрические размеры элементов печатного

проводящего рисунка передаются в конвертиро�

ванный документ без искажений.

Что касается атрибутов элементов проекта P�CAD, то не все на�

стройки корректно передаются в правила проекта Altium

Designer. Так, например, при том, что значения физической ши�

рины печатных проводников, установленные в P�CAD как ат�

рибуты классов цепей, передаются в графический PCB�образ

верно, в правила Altium Designer эти значения не попадают.

При передаче параметров зазоров между элементами печатного

проводящего рисунка значение глобального атрибута Clearance,

назначенного классам цепей в P�CAD для всех пар элементов, в

Altium Designer разворачивается в набор правил для каждой из

пар объектов печатного рисунка (линия   линия, линия   КП,

КП   КП и др.), и при этом значение величины зазора, установ�

ленное в P�CAD, передается каждому их этих правил.

Не передаются также параметры защитной маски контактных

площадок и переходных отверстий.

Таким образом, для успешного продолжения работы над конвер�

тированным проектом следует внимательно рассмотреть и, в не�

обходимых случаях, отредактировать правила проектирования.

Для поддержания принятой в Altium Designer структуры про�

екта конвертированный схемный документ и документ печат�

ной платы следует объединить в единый проект. Структура

объединенного проекта отображается в панели Projects.

Далее следует восстановить связи схемных компонентов с

компонентами печатной платы. Для этого служит команда

Project →Component Links.

При конверсии документа печатной платы также генерируется

файл <имя_проекта>.OUTJOB (рис. 11). Этот файл включает�

ся в ветвь Settings дерева структуры конвертированного проек�

та печатной платы и представляет собой оболочку, которая мо�

жет быть наполнена выходными данными проекта, в точности

так же, как формируется пакет выходных данных по команде

главного меню File →New →Output Job File. 

Наполнение оболочки производится по командам контекст�

ных меню, активизируемым щелчком правой кнопки мыши в

строках левого поля, например, Fabrication Outputs/Add New

Fabrication Output. Указывая курсором команды контекстного

меню, составляем список массивов выходных данных, подле�

жащих экспорту.

По двойному щелчку левой кнопки мыши в строках колонки

Output Description активизируется диалог настройки соответст�

вующей функции экспорта результатов проекта.

В правом поле оболочки *.OUTJOB располагаются пиктограм�

мы, обозначающие среду, в которую выводятся экспортируе�

мые данные:

� Print To Microsoft XPS Document Writer   печатать на принтере;

� Publish To PDF   публиковать в PDF�формате Adobe Acrobat;

� Publish To WEB   публиковать в формате Internet Explorer;

� Generate Files   генерировать файлы: эта функция исполь�

зуется при формировании управляющих файлов для свер�

ловки (NC Drill), фотоплоттера (Gerber Files), при экспор�

те в формате ODB++.

Так, например, при выборе в контекстном меню команды

формирования управляющих файлов для фотоплоттера и ак�

тивизации функции Generate Files генерируются файлы по�

слойных фотошаблонов. Эти файлы включаются в ветвь

Generated/CAMtastic Documents дерева логической структуры

активного проекта, отображаются в панели Projects и визуали�

зуются программным модулем CAMtastic в главном графичес�

ком окне программы (рис. 12).

В отличие от формирования Gerber�файлов непосредственно

в среде Altium Designer, при формировании их в оболочке

*.OUTJOB возможна визуализация послойных фотошаблонов

только по одному, а не всех сразу. Это несколько затрудняет

визуальный контроль фотошаблонов на совпадение контакт�

ных площадок в слоях печатной платы, наложение надписей и

линий шелкографии на контактные площадки, выявление

других дефектов.

В заключение следует отметить, что в то время как конверсия

библиотек P�CAD в Altium Designer проходит без каких�либо

осложнений, для перевода проектов P�CAD в формат Altium

Designer потребуется серьезная и внимательная работа в части

исправления ошибок конверсии и редактирования правил

проектирования в среде Altium Designer.

Владислав  Суходольский
CSoft
Бюро ESG,

специалист по Altium Designer и P
CAD,
доцент кафедры микрорадиоэлектроники

и технологии радиоаппаратуры
СПбГЭТУ "ЛЭТИ"

программное обеспечение
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